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Making a Smooth Transition from OrCAD  
Capture to Altium Designer Develop
In this guide, we’ll focus on importing OrCAD Capture designs. Please refer to specific guides if you need to migrate 
other files.

Legacy Translation

Before You Begin

This guide will show you how to import data from your legacy system into Altium Designer Develop. Before importing 
all of your legacy data, it’s important to ask yourself, “why do I need to import my legacy data?” Below are some of the 
most common considerations to consider when deciding whether to import legacy data into Altium Designer Develop.

After reviewing these considerations, read on to learn how to import your legacy data into Altium Designer Develop.

•	 Does the legacy data include critical information for 
creating robust designs within Altium?

•	 Is it easier to start new designs rather than re-work 
the imported data to make it usable? •	 How do you maintain library integrity?

•	 Who has design authority?

•	 How do you plan to verify the data?

•	 How do you plan to verify the imported data?

•	 How much re-work is going to be needed after 
importing?

•	 Do you need to take advantage of additional 
Altium Designer Develop features once the data is 
imported? 

•	 Are there any exotic parts that you may have trouble 
representing within Altium?

•	 Do you need to add Altium-specific features (like 3D 
models) for every part?

•	 How much redundancy, duplication, and error is 
present in your library?

We have 20 years of data, and I don’t 
want to leave it behind.

Our service bureau doesn’t use Altium, 
but they can import Altium data. Our 
Altium system can import their data. 
Is this a reliable way to pass designs 
between our companies?

We have a library of trusted parts which 
we’d like to bring into Altium.

We have some ‘golden’ designs that 
we need to bring into Altium Designer 
Develop so that we can up-issue them.
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Preparing to Migrate Your Legacy Data

There are four phases to migrating legacy data. 

Step 1: Prepare Original Data

It is prudent to clean up your design before attempting to export. Below is a checklist of data cleanup best practices to 
help you as you prepare your data:

Schematic considerations:

•	 Individual pin connectors (example: Block connectors) 
in Capture must be modified at the Capture tool level 
before migration. Alternatively, you can replace pin 
connectors in Altium Designer Develop post-migration.

•	 Connectors should be represented as one-gate-per-pin 
with over 256 “gates.”

•	 Ambiguous connectivity for reuse blocks must be broken 
apart in Capture. 

•	 Remove hidden pins or implicit connections.

•	 Local net names placed at wire intersection must be 
placed at correct locations (away from intersection 
point)  

•	 Are schematic symbols mapped to correct PCB 
footprints or not?

•	 Schematic and PCB are in sync?

1. Prepare original data

•	 Check content

•	 Remove redundant or confusing data

•	 Verify integrity

2. Export data

•	 Save data in a format suitable for 
import into Altium Designer Develop

3. Import data

•	 Save «raw» imported data

•	 Integrity check

4. Post import

•	 Add Altium-specific objects

•	 Tidy up

•	 Final integrity check

Library considerations:

•	 Do the schematic symbols match with PCB 
footprints?

•	 Does the library contain correct supply chain 
information and BoM parameters?

•	 Does 3D information need to be imported? If yes, 
then the height attribute should be assigned in 
OrCAD Capture.
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Step 2: Save Data in a Suitable Format

Supported Version and File Formats

The following table shows Capture PCB Design Formats and versions that can migrate into Altium Designer Develop. 
This list is updated regularly, so please check with us before starting a new migration. Refer to this link for updated 
information.

The following file types are supported:

•	 OrCAD Capture (*.DSN) files 

•	 OrCAD Schematic Library (*.OLB) files 

•	 OrCAD Layout (*.MAX) files

TYPE SYSTEM VERSION FORMAT

Schematic OrCAD Capture 17.4 ASCII (.dsn)

Schematic Library OrCAD CIS 17.4 ASCII (.olb)

Legacy PCB OrCAD Layout V9.2.3 ASCII (.max)

https://www.altium.com/documentation/altium-designer/design-tools-interfacing#!extensions-to-interface-to-other-eda-design-tools
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Phase 3: Import Data into Altium Designer 
Develop

Using the Import Wizard for OrCAD Files

Launch the Import Wizard from the Altium Designer 
Develop File menu. Choose the OrCAD Designs and 
Libraries Files option, as shown below. On the “Importing 
OrCAD Designs” screen, click the Add button to choose 
OrCAD design files. You can translate multiple files at the 
same time. Step-by-step instructions on using the Import 
Wizard are to follow.

•	 Start the Import Wizard with File » Import 
Wizard

Starting the Import Wizard for OrCAD files

Step-by-Step Import Instructions on Importing  
an OrCAD Design file (.DSN)
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•	 Select Type of Files to Import—>OrCAD Designs and 
Libraries Files

•	 Add the file(s) to be translated. In this case, the 
“CYCLONEIII_SB_3C25.DSN” file has been used.

NOTE:  
You can add as many OrCAD Design files as you like at this point. However, if you add files of a 
different name, Altium Designer Develop will create separate projects.
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Add any Schematic or PCB Libraries to import (if 
available).

•	 Set the options for what level of reporting is done 
after the translation has completed.
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•	 Select whether you want to convert OrCAD 
component rectangles to Altium Designer Develop 
rectangles and use Off-Page connectors of OrCAD 
as Altium Ports.

•	 Set your desired Schematic Sheet options, including 
how Title Blocks are imported and Pin-to-Pin spacing 
options.
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•	 Set your Schematics Parameter and Net Connectivity 
Options. Here you can choose to Auto-position 
the Parameters, and also Disable “Mark Manual 
Parameters”.

•	 You will see a preview of the files being translated 
and their output directories. You can change the 
main output directory if desired.

•	 Click the final Next button. The Import Wizard will 
take care of the rest.
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•	 Congratulations, your design has now been imported 
into Altium Designer Develop! 

•	 Follow the Post Import Tidy Up checklist to ensure 
the design has been fully reviewed and verified. 
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Step 4: Post Import Tidy Up

Once your migration is complete, we recommend checking your design to ensure that all data is transferred as 
expected. Below is a list of key checks to perform post-migration:

Physical check

•	 View » Fit Document

•	 Board shape and cutouts

Electrical check

•	 Netlist

Rules

•	 Have all rules been imported

•	 DRC check

•	 Check settings for polygons - Island removal, min 
primitive size

•	 Thermal reliefs, direct connect

•	 Check power plane settings

•	 Power plane Pull-back

•	 Solder mask, Paste mask rules

•	 Via Tenting

•	 Testpoint assignments

Power check

•	 Nets

•	 Planes

•	 Polygons

Documentation check

•	 Layers

•	 Text/Strings

•	 Legends

PCB reports

•	 Number of components/nets

•	 All nets routed
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Making a Smooth Transition from 
Cadence Allegro/OrCAD PCB Editor 
to Altium Designer Develop

In this guide, we’ll focus on importing Allegro/OrCAD Layout PCB designs. Please refer to specific guides if you need to 
migrate other files.

Step 1: Prepare Original Data

It is prudent to clean up your design before attempting to export. Below is a checklist of data cleanup best practices to 
help you as you prepare your data:

PCB considerations:

•	 Large numbers of graphical objects like mechanical 
drawing or non-ECO-registered drawing primitives must 
be migrated on documentation layers.

•	 Star point grounding check.

•	 Remove deliberate DRC violations.

•	 Remove objects extending beyond the environment.

•	 Known PCB layer assignments need to map correctly 
with existing Altium Designer Develop PCB, especially 
with the power plane or signal layer.  

•	 Do the auto-named nets match with the schematic?

Library considerations:

•	 Does 3D information need to be imported? If yes, 
then the height attribute should be assigned in 
Allegro.

•	 Correct representation of custom Allegro, copper 
shapes, solder mask, and resist?

Step 2: Save Data in a Suitable Format

Supported Version and File Formats

The following table shows the versions of all Allegro design formats that can be migrated into Altium Designer Develop. 
This list is updated regularly, so please check with us before starting a new migration. Refer to this link for updated 
information.

The Altium Designer Develop Import Wizard handles both Allegro PCB Design files (*.brd) and Allegro ASCII Extract files 
(*.alg). If you have Allegro PCB Editor installed, you can directly translate Allegro PCB Design files (*.brd) into Altium 
Designer Develop PCB files (*.PcbDoc)

TYPE SYSTEM VERSION FORMAT

Schematic Allegro up to 17.4 ASCII (*.alg)

https://www.altium.com/ru/documentation/altium-designer/interfacing-to-other-design-tools-overview/#!extensions-to-interface-to-other-eda-design-tools
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PCB files translate to Altium Designer Develop as follows:

ALLEGRO FILE TYPE ALTIUM DESIGNER DEVELOP FILE TYPE

Allegro Binary PCB Design files (*.brd) Altium Designer Develop PCB files (*.PcbDoc)

Allegro ASCII Extract Files (*.alg) Altium Designer Develop Schematic file (*.SchDoc)

Using ASCII Conversion to Import Without Allegro Installed 
on the Same Workstation as Altium Designer Develop
An Altium Designer Develop workstation with no licensed Allegro installation can import Allegro ASCII Extract files 
(*.alg). The following procedure enables a Licensed Allegro user to convert Allegro binary *.brd files to Altium compatible 
*.alg files. However, you must run this conversion on an Allegro-licensed machine.

1.	 Locate the following two files in the \System folder of your Altium Designer Develop installation (Summer 08 or 
later):

•	 Allegro2Altium.bat

•	 AllegroExportViews.txt

1.	 Copy the two files to the folder containing the *.brd file.

2.	 Open a command prompt, navigate to the folder containing these files and type the following: Allegro2Altium your_
file.brd (your_file = file name)

3.	 Surround your filename with double quotes if the filename contains spaces, i.e., Allegro2Altium «yourfile.brd»

4.	 Your Allegro-licensed machine will create an ASCII file will create an ASCII file and place it in the folder with a *.alg 
extension. Copy the *.alg file to the Altium Designer Develop workstation and import using the Import Wizard.
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Step 3: Import Data into Altium Designer Develop

Using the Import Wizard for Allegro Design Files

You can launch the Import Wizard from the Altium Designer Develop File menu. Follow the step-by-step instructions on 
how to use the Import Wizard throughout your data migration.

Step-by-Step Import Instructions on Importing an Allegro ASCII PCB Design file.

•	 Start the Import Wizard with File » Import Wizard

•	 Select Type of Files to Import—>Allegro Design Files

 Starting the Import Wizard for Allegro files

NOTE:  
You can also start the Import Wizard by dragging your Allegro Design Files into  Altium Designer 
Develop’s Projects Panel. This action will automatically launch the wizard in Allegro Import mode.
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•	 Add the file(s) to be translated. In this case, 
‘CyclonelII_SB_3C25.ALG’ has been used.

•	 Add Constraint File or Footprint —> If available and if 
you would like to add.

NOTE:  
You can add as many *.brd and *.alg files as you like at this point. In the file browser, change the file 
types pull-down to choose .brd or .alg files, depending on what you want to import. However, the 
Import Wizard will create separate projects if you add different file types.
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•	 Use the Reporting Options page to enable or disable 
the settings for logging all errors, warnings, and 
events, respectively.
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Layer Mapping 

The Import Wizard provides the default mapping to build the layer mapping for each PCB. You can customize layer 
mapping for each design you choose to import. You may wish to import multiple Allegro PCB designs and map the same 
Allegro layer to the same Altium Designer Develop layer. You can set your layer mapping once and use this configuration 
for all of your import files if you want.

Setting layer mapping is an advantage because batch layer management can save time when importing multiple 
designs. The disadvantage to using layer mapping is that Default Layer Mapping is not always intelligent with differing 
structures in designs and may require some manual changes.

Right-click on the Altium Designer Develop Layer 
Mapping list (or use the dropdown) to manipulate 
the layer mapping of Allegro PCBs to Altium Designer 
Develop PCBs. You can even disable the layers which are 
not required on the Altium Designer Develop side or are 
not relevant. By default, the Import Wizard will map all 
layers.

You can use the Load and Save Layer Mapping 
Configuration Files command using the Load Layer 
Mapping and Save Layer Mapping menu items, 
respectively, to quickly apply layer mapping for Allegro 
and Altium Designer Develop layers.

Altium Designer Develop supports the default 30-layer 
mode and the expanded 250-layer mode for Allegro PCB 
files. If the user customizes the default layer mappings, 
those settings can be saved to a configuration file 
so that you can quickly reuse those mappings for 
subsequent translations.

•	 The Import Wizard presents users with several 
options to control the translation from Allegro to 
Altium Designer Develop. Specify Polygon Connect 
and Plane Connect options for the PCB import 
process appear at this stage. Enable the Import 
Auto-Generated Copper Pour Cutouts option to 
import the auto-generated voids in Allegro PCB 
Editor as cutouts when the file is translated. The 
default options are displayed below.
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•	 Click the final Next button, and the Import Wizard 
will take care of the rest.

•	 Congratulations, your design has now been imported 
into Altium Designer Develop!

•	 Follow the Post Import Tidy Up checklist to ensure 
the design has been fully reviewed and verified. 

•	 Make it to where you can view the link ‘Bringing 
Together Imported Schematic and PCB Designs’ 
guide.

•	 You will now see a preview of the files selected for 
translation, along with their output directories. You 
can change the main output directory at this point if 
desired.

https://docs.google.com/document/d/13VKNblKIMGV8ZAObjMJAX5oNfGH38Aof/edit
https://docs.google.com/document/d/13VKNblKIMGV8ZAObjMJAX5oNfGH38Aof/edit
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Getting Help
There are many ways to learn more about Altium Designer Develop:

•	 F1 over any object, editor, panel, menu entry, or button to open a brief description in your web browser

•	 Press Shift+F1 or ~ key while running a command for a list of shortcuts you can use in that command.

•	 Access our complete Altium Designer Develop Documentation online.

•	 Visit the Altium Video Library where you can watch training on over 150 different topics. Each video walks you 
through the steps needed to complete a task.

•	 All Altium Designer Develop subscription levels include easy access to real-time support, user communities, 
comprehensive product documentation, training videos, and knowledge base of targeted solutions for common user 
experiences. Contact Altium Support Here.

https://www.altium.com/documentation/altium-designer
https://altiumvideos.live.altium.com/
https://www.altium.com/support
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Additional Resources
Online Resources:

If you’re ready to dive deeper into the powerful features of Altium Designer Develop, below is a list of articles that 
provide information to help you get started.

•	 For a full overview of the PCB design process with Altium Designer Develop, check out this tutorial: A Complete 
Design Walkthrough with Altium Designer Develop.

•	 For a look at the basics of creating components, read A Look at Creating Library Components.

•	 For a tutorial that steps you through all the basics of editing multiple objects, take a look at Schematic Placement 
and Editing Techniques in Altium Designer Develop.

•	 For an overview of How to Start an FPGA PCB Layout in Altium Designer Develop, read How to Start an FPGA PCB 
Layout For Your Embedded System.

Software Platform Resources:

Another great way to get the most out of your Altium 
Designer Develop installation is by exploring its help 
section. You can launch the help menu on the left side of 
Altium Designer Develop by clicking Help and navigating 
to Exploring Altium Designer Develop.

https://www.altium.com/documentation/altium-designer/tutorial
https://www.altium.com/documentation/altium-designer/tutorial
https://www.altium.com/documentation/altium-designer/creating-file-based-library-components
https://www.altium.com/documentation/altium-designer/schematic-placement-editing-techniques
https://www.altium.com/documentation/altium-designer/schematic-placement-editing-techniques
https://resources.altium.com/p/how-start-fpga-pcb-layout-your-embedded-system
https://resources.altium.com/p/how-start-fpga-pcb-layout-your-embedded-system
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Appendix: Translating  
OrCAD in Altium Designer Develop

Sheet Structure in OrCAD Capture’s Project Manager

Like Altium Designer Develop, OrCAD Capture supports 
flat and hierarchical designs. Both software tools use a 
block-like symbol to define a sheet-to-sheet structure.

•	 Altium Designer Develop uses Sheet Symbols

•	 OrCAD Capture uses Hierarchical Blocks

The sheet symbol references the lower-level schematic 
in Altium Designer Develop and OrCAD Capture. In 
Altium Designer Develop, the lower level schematic is 
simply another schematic sheet. However, the Capture 
schematic references can be more complex.

Capture has two layers of design partitioning that affect 
hierarchy.

•	 Schematic documents: these appear as folder icons 
in Capture’s Project Manager

•	 Pages: These appear as schematic sheet icons. 

Each Capture schematic can contain one or more pages. 
The Capture hierarchical block points to the schematic 
below, which means the block can reference circuitry 
divided over multiple pages.

Typically a flat design in Capture is one schematic 
(folder), with the design created on as many pages as 
required in that schematic (folder). For a hierarchical 
design, the hierarchical block symbol (or part with an 
attached schematic sheet or model) is used to partition 
the major functional regions of a design.

Each hierarchical block or VHDL model represents 
a unique design module for a simple hierarchy. The 
Hierarchy tab in OrCAD Capture’s Project Manager 
displays a simple hierarchical design as a tree of 
schematic pages. The root module is called the 
schematic folder or VHDL entity at the top of a hierarchy, 
which directly or indirectly refers to all other modules in 
the design. In the OrCAD Project Manager’s File tab, the 
root module has a backslash on its folder icon, shown 
below. The root module folder and any other module 
folder can contain as many schematic pages or VHDL 
models as required.
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Defining Net Connectivity

In OrCAD Capture, net connectivity uses net aliases, 
off-page connectors, hierarchical blocks, hierarchical 
ports, and globals. Nets between schematic pages 
within a single schematic folder are connected through 
the off-page connectors, while the hierarchical blocks 
and ports connect the nets between the schematic 
folders. Globals are used to connect power/ground nets 
throughout the design.

Project Panels - On the left is the structure of an example CPU_Design project as 
it would appear in OrCAD Capture. On the right is the same project CPU Design 
after import in the Projects panel of Altium Designer Develop.

Altium Designer Develop uses a similar set of net 
identifiers to create net connectivity. Within a schematic 
sheet, you can use Wires and Net Labels. Between 
schematic sheets, nets in a flat design are typically 
connected using Ports, but Off-Sheet Connectors 
are also available. Nets in a hierarchical design are 
connected from a Port on the lower sheet to a Sheet 
Entry of the same name in the sheet symbol that 
represents the lower sheet. Power/ground nets are 
connected using Power Ports.


